CJV150/300/300 Plus Metallic Color Printing Guide Mimaxi

This manual describes the effects that can be expressed when silver ink is used in CJV150/300/300 Plus, and
how to set and print them.
Please read this manual carefully and use it correctly.

Note

* Itis strictly prohibited to write or copy a part or whole of this document without our approval.

» This document has been carefully prepared for your easy understanding, however, please do not hesitate to
contact a distributor in your district or our office if you have any inquiry.

+ Description contained in this document are subject to change without notice for improvement.

» Copying the Mimaki Engineering Co. Ltd. software described in this guide to other disks (except for backup
purposes) or loading it to memory except for the purpose of running it, is strictly prohibited.

» Due to improvement or change of software, the description of this document could be partially different in
specification, for which your understanding is requested.

» With the exception of what is provided for in the warranty provisions of MIMAKI ENGINEERING CO., LTD., we do
not assume any liability against the damages (including but not limited to the loss of profit, indirect damage,
special damage or other monetary damages) arisen out of the use or failure to use of this product. The same shall
also apply to the case even if MIMAKI ENGINEERING CO., LTD. had been notified of the possibility of arising
damages in advance. As an example, we shall not be liable for any loss of the media made using this product or
indirect damages caused by the product made using this media.

* You can also download the latest operation manual from our website.

Notations used in this document
+ Items and buttons displayed in menus and on screens are marked with square brackets ([ ]) as in [File].

Screen image used in this document

» The explanation is based on the screen image of RasterLink6Plus as an example.
» RasterLink6Plus and RasterLink7 are referred to as RasterLink in together.

Symbols

porantd) This symbol indicates important information for using this product.

bl » This symbol indicates useful information.

?-lE.E

RasterLink is the trademarks or registered trademarks of MIMAKI ENGINEERING CO., LTD. in Japan and in other
countries.

Adobe, the Adobe logo, Acrobat, lllustrator, Photoshop, and PostScript are the trademarks or registered trademarks
of Adobe Systems Incorporated in the United States and other countries.

CorelDRAW is a trademark or registered trademark of Corel Corporation in Canada, the United States and other
countries, and its affiliates.

Microsoft and Windows are trademarks or registered trademarks of Microsoft Corporation of the United States and
other countries.

Apple and Macintosh are trademarks or registered trademarks of Apple Inc. of the United States and other coun-
tries.

Other company and product names mentioned herein are the trademarks or registered trademarks of the respective
companies in Japan and in other countries.


https://manuals.plus/m/c15547628c5311b2440183121570292f120eb55037ce409356a8ac8cf3467ab2

Applicable environment

CJV150/300 FW Ver.1.40 later
CJV300 Plus FW Ver.1.20 later
Ink SS21 silver ink

When using RasterLink6Plus: The version that is compatible with the printer you use.
When using RasterLink7:Ver.5.4.0 or later

RasterLink6Plus Ver.2.3 or later
RasterLink7 Ver.1.3.0 or later

Others RasterLinkTools Ver.1.3 or later

Printer

Mimaki Driver

RIP
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Before printing the silver ink, please check first

Printer setting
T e T e e e P e e e P L E T L AN e el
Make the following settings on this machine.

B For setting "OFF" the [LOGICAL SEEK]
By setting the logical seek, operation of the head will change at the time of print. For details, refer to the
Operation manual of this machine.

B Set the [DRYING TIME] to "0.0 seconds"
For setting the drying time of ink. For details, refer to the Operation manual of this machine.

1 Turn on the machine.
| ]

+ For details, refer to Chapter 2 “Turning the Power On” in -
this machine's Operation manual. ;

b

h
A .
. - ", Power supply switch
..‘."-\.l{{{{d_”-%"-\.. II"'l,| i o -
B -, n, - .
;r‘el!l -..\'"-.. h"\-. Il' J.- |I.- "-.-..

2 Set of the [LOGICAL SEEK].

(1) In local, press (MENU) st ("imten ).
+ Display the “SETUP MENU"”.

(2) Press £ 5.4 3 times, then press {_Enten_j.
» “LOGICAL SEEK” is selected.

(3) Press k= 4t 54 to select “OFF”, then press {_inren ).
* Return to [SETUP MENU] screen.

3 Setting of [DRYING TIME].

(1) Press £33 once, then press {_Entes ).
» “DRYING TIME” is selected.

(2) Press k= 4t 5 4 to select “SCAN?”, then press {_Enten _J.
« Setting screen of drying time is displayed.

(3) Press k= 4t 5 4 to set drying time to “0.0s”, and then press {_intEn J.

4 Press several times to return to [LOCAL].
| ]




Confirmation of appropriate printing conditions

The color of the print using the SS21 silver ink is very different from the color to be displayed in the preview of
the application.

Because there is image quality varies depending on the media you want to use, you need to make sure the
first printing conditions suitable for the media.

After confirming the printing conditions, it is recommended that you create a color swatch of silver
monochromatic and metallic color in printing conditions suitable for the media.

@ Create a silver monochromatic color swatch
Even in the case of media that do not have a metallic color profile, in order to use your silver ink effectively,

please output the following color swatch and check the print condition that matches the media.
Here, explain the procedure to print a two-layer print.

Mmakr

Check the setting of Color Collection.

Film Fumndio maranments

Working Disk(Q RGEE Color char ‘

» Choose [Color Collection ...] from [Tool] menu.

WY Color chai
ﬂ. Cughts2]_ @rocish Cnbas chuast

EE—

i

Make sure that the use columns of "SS21

[ L Eatbiom
Metallic Color" and "MIMAKI RasterLink" are i-:a-—_ TR E—
checked. e )| s -
—— J" e i dn = e -
« Put a check if the use columns are not checked. (UORCIASESIRECECTTT 1) SR iy

Select [Open...] from [File] menu of Fanchion Tool Emv

RasterLink.
Opan. Crl+0
Restore Cirl+R
Exil Cirl+0

Select the image in the following folder, and then click button.
+ C:\MijSuite\ColorChart\Default\SilverInkLimiTestChart.pdf

From [Job List] panel, select the image (job) ‘
that is read. b i -T - — ]|

Click [Layer] - _ - icon.




7 In [Layer Adjust] panel, select the "Special | -
" Color — Color" for [Special Color Over ) p—
Print]. '

8 Click [Quality] [ 7] icon.

9 In [Print Quality] panel, set the printing condition.

(1) Select a metallic color profile for the media to be used or of the same material as the media to be
used.

+ Metallic color profile will have a [Si] to the end of the media name.

(2) In [Device Adjustment], select “Profile Setting”.

(3) Select the “ColorMatching OFF” in the preset of [Color Matching].

| P | ¢ = R

::"mr--- - :: l -n';l‘rl"l—-"'.,_'_l I u
(1) { JTIET & A e WG !.]

(©)

10 Click [Execution] [} icon.

11 In [Execution] panel, select “RIP and Print”, [
* and then click (Start] button.




1 2 Check the image quality of printed silver monochromatic color swatches.

il

?-lF:-:

How to check the quality of the silver ink

» The patch of silver monochromatic color swatches, of which color concentration is 100% and does
not occur the bleeding, banding and blurring, and form a uniform print surface can match the
printing conditions of the media to be used.
Please use this as a color swatch of silver.
If the image quality of 100% of the patch is bad, please proceed to Step 13.

MmaKn

Example of good
image quality

Example of poor image quality

Bleeding Roughness Banding
Bleeding :Many ink amount, or it becomes whitish full of ink at the edge of the patch.
Roughness :Ink amount is insufficient, such as hoarse roughness occurs.

Banding : Ink is insufficient, stripes occurs in scan direction.

13.

Click [Quality] | #] icon.

14.

» Create a new [Color Adjustment Set].

Click [Color Adjust] tab. ==

Adjust the concentration of silver ink.

Method of adjustment the concentration of silver ink

« If the bleeding at 100% of the patch in step 9 has occurred, see a patch of silver monochromatic
color swatches, and look for the concentration that image quality is good.
Reduce the silver ink concentration to match the concentration of the patch.
Example) A good image quality at 70% — setting

value : -30% |
LT RS Y |

Lol

» The roughness and banding at 100% of the patch in step 9 have occurred, increase the
concentration of Silver ink.

Example) setting value: + 10% (the silver ink amount can be changed between -50% ~ + 50%).

1 6 Go back to Step 10, to print again.

ol

?-lF:-:

« If the adjustment of the concentration of silver ink not improve image quality in step15, select a
metallic color profile for another media, then try again from step 9.




@ Print a color swatch of metallic color

You can print a color swatch of metallic color swatch which can be used in Adobe lllustrator.
You can check the settings of the print to overlay the color ink in silver ink.
Here, explain the procedure to print a two-layer print.

1 i Check the setting of Color Collection. == me[mmnmﬂl

working Disk(d RGE Color char
CWYH Color chai

» Choose [Color Collection ...] from [Tool] menu.

ﬂ. Wl Qrooval Cnlar Gy
IE= [ oo Cotecion |
Make sure that the use columns of "SS21 11 e et
* Metallic Color" and "MIMAKI RasterLink" are | cwcsss T
checked. ——ru D] i
;,;,,,7, — .:- e Calm = e =
« Put a check if the use columns are not checked. (UMMM IRECOCTTE 1)} -SSR S o

,}:i:i;; » Check “SS21 Metallic Orange Color” as well when using orange ink.

-

-

3 Read the PDF of metallic color collection. A DT
| | g el w e
f Open

» Choose [Open] from [File] menu. Cirl=0 .,;
Ext CH-Q  bio

4 Select one of the following five types in the folder of the image, and click
* the button.

+ C:\MijSuite\ColorChart\Default
(1) Metallic Color Collection A.pdf

(2) Metallic Color Collection B_1.pdf
Metallic Color Collection B_2.pdf
Metallic Color Collection B_3.pdf

(3) MetallicColorCollectionB_OrInkEdition.pdf
(4) Metallic Color Collection C.pdf
(5) MetallicColorCollectionC_OrlnkEdition.pdf

sal;i;: This is a pattern covering all SS21 metallic color library.
'_'lF—.' (1) Metallic Color Collection A
: "o '-“f Can confirm the finish of metallic color.
= F




-b-"l--.F (2) Metallic Color Collection B_1
e Metallic Color Collection B_2

Metallic Color Collection B_3
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(3) MetallicColorCollectionB_OrInkEdition
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(4)

(5) MetallicColorCollectionC_OrinkEdition

Can be used as a seal-shaped sample.

The concentration of CMYK each color is also
described.

When you create a booklet, cut after the
lamination process.

Can cut to be on A4-size booklet.

Can be used as a seal-shaped sample as with the
color chart in (2).
Use orange ink to print.

Can be used as a color swatch in the small
bundles.

The concentration of CMYK each color is also
described.

When you create a booklet, cut after the
lamination process.

Can be set in small bundles and used as a color
swatch as with the color chart in (4).
Use orange ink to print.

5 Click [Layer] - ; - icon.




6.

In [Layer Adjust] panel, select the "Special - e

Color — Color" for [Special Color Over i -
Print].
7 Click [Quality] |[#] icon.
n
8 In [Print Quality] panel, set the printing condition.
u
(1) Choose a metallic color profile.
» Metallic color profile will have a [Si] to the end of the media name.
(2) In [Device Adjustment], select “Profile Setting”.
(3) Select the "ColorMatching OFF" in the preset of [Color Matching].
e e— — === ¥l
1) 4‘(.-':1.,-"-": — ] |
F———— = (3)
i e
elts « If the density adjustment of silver ink is
e _l?: needed, specify the [Color Adjustment

printed with metallic color collection.
In [Information label] screen, when check "Add Label", the
print information label can be added to the print.

FomaEtion [

o) AonLabel

« When you print by adding a print information label, you can check the date and print conditions

mmmmﬂ

9 Click [Execution] [*] icon.

10 Select [Execution] in the tab "RIP and Print", and then click the button.
n




Preparation for the application

B Open a Swatch Library in the application
Make the Swatch that was printed in the color swatch of metallic color be used in applications.

In the case of Adobe lllustrator

1 Click the [Swatch Library Menu] button in
" the Swatches panel (window). Sawali oy
EElm B J.-r-!'{hi

]
R T«D7TEEBE
 AEEw

Bxi
-]

2 Click “Other Library...” menu.

Barttden Macislask)
Syvbern (Windowil
Tewniles

WinlBerd

el

Ergliah. thel
Al 55 ] Metalbc Color Library

| Critamr Liksrary... l

3 Select a swatch file in the following folder.
u

» Folder location : C:\MijSuite\Swatch\lllustrator

» Swatch files : MIMAKI SS21 Metallic Color Library.ai
MIMAKI RasterLink Library.ai
MIMAKI SS21 Metallic Orange Color Library.ai

H Install the RasterLinkTools

For information about how to install RasterLinkTools, please refer to the separate “RasterLink installation
guide”.

-10 -



B Choose the color collection
Before read the job to RasterLink, select the metallic color collection that were in the way of printing a
metallic color.
« If you change the setting of color correction, it will not be reflected in the color replacement of

existing jobs.
If you want to apply a different color collection, re-create the job again.

In the case of 2-layer printed

1 Select the [Color Collection ...] from [Tool] _ —).
" menu of RasterLink. fite Funcesy [ Jimaronments

pridng Disk (0 RGE Color chan
+ Use "SS21 Metallic Color" including the silver ink to Pﬂ ¥ CMYK Color chart

the output. _l Prntar | Crernal Cniae char
)

L P APy —

2 Remove the check from the use of column {1 ke Lo

" "SS21 Metallic Color (No Silver)". [ep— T .
[ i Dl [T Ry e———"
S e s SR L R R = e
Lz Figme ey ol ‘.-l-l:!'_.a.- el o]
sl Also deselect “SS21 Metallic Orange Color(No g e I Nt -
a_t Silver)” from the Use column when using orange ink. [T a T —

-

3 Click button.
[ |

In the case of Pull-back printing
Use the "SS21 Metallic Color" of which concentration of Silver ink is 0 to output.

1 Select the [Color Collection ...] from [Tool]

menu of RasterLink. Fite Funcacly [ [:enaranments

Fﬂmmm‘ RGE Color chard
I'-"r|-.rI:I e e

Jm CANYE Color chard
T |

Lo PSP —

2 Remove the check from the use of column [

" "SS21 Metallic Color". [ e TR v
e F e

a:lT: + Also deselect “SS21 Metallic Orange Color” from the ﬁi_i-%
'-_-lg-w' Use column when using orange ink. - i 2y

3 Click button.

-11 -



How to print metallic color

When you print the SS21 Silver ink in RasterLink by using the following three plates, there are two printing
methods.

Metallic color plate : Color overlaying the silver ink

Color plate : Color which is not superimposed on the
silver ink

Silver plate : Range of printing the silver ink

1. 2-Layer printing
A s = Nl L B A S S o e s 2 L ol e e
(1) Metallic color plate, color plate, and a silver plate printing at once.

2. Pull-back printing

B e e L P W o P A G A P o S e v
(1) Printing color plate and a silver plate for the first time.

(2) Pull back the media.
(3) Print a metallic color plate for the second time. -

Advantages and disadvantages comparison table of the two-layer printed and pulled back print

2-Layer printing Pull-back printing

Color plate, Silver plate, and metallic color Improve the metallic tone more than 2-layer

Merit plate can be printed without deviation. print.

In the high part concentration of ink, metallic | Depending on the conditions, there is a
Disadvantage tone will be reduced. case that color plate, silver plate, and metal-

lic color plate are printed displaced.

Limit of print None Yes
range
Speed Equivalent to the Pull-back printing Equivalent to 2-layer printing

*1.Please refer to "Notes on Auto pull-back print" on the next page for more information.

-12 -



Notes of Auto pull-back print

1. Prevent the displacement of image

In Pull-back printing, the image may be displaced in the first time and the second time of print. Please note

the
1.1

1.2

following points.

Pinch roller position and number
Recommended conditions

» Media width is equal to or greater than 1000mm
As to be symmetrical with respect to the center of the media, more than four places.
* Media width is less than 1000mm

As to be symmetrical with respect to the center of the media, more than two places.
Set the roller pressure to "H" in any case.

If the roller number is less than above setting, it may cause the first and second image shifted.

Sheet feed
When the first time and the second time of print media of different tension, it will cause the image to
be shifted.

By loosening the media that was set before print manually, the displacement of the image can be
reduced..

2. Size of image and limit of arrangement

Due to the pinch rollers and machinery on the structure, in the Pull-back printing there is a limit to the size
of the image that can be printed.

2.1

Width direction

With respect to the set the pinch roller, avoid the image to ride on the track of the roller.
When the pinch roller passes over the printed image, it will cause the roller trace is attached.

* Printable range example of 1300mm media width:
Width of the printable range
390mm x 2, 340mm x 1 410mm x 2 800mm x 1
= ’ : =
o

7l § e
Pinch roller position Media Printable range
(Unprintable) (Unprintable for narrow width)

2.2

Feed direction

The maximum length of the print data is 1000mm.
If it is too long, the printing surface contacts with the floor and there is a risk of quality deterioration
such as dirt and rubbing.

3. About the quality of the image

Pull-back printing compared to the two-layer print can be used to improve the metallic tone by a longer
drying time of the silver plate, but quality vary by printing length.

* Printing length is 500mm or less
Set the print after the waiting time of about 5 to 15 minutes and you will be able to obtain a constant

quality. (On the panel of the machine, dry time — print end, set 300 ~ 900s.)
* Print length is longer than 500mm

Not need to set the print after the waiting time

-13-



Let's printing using Silver

Here, by taking a concrete example, describes the flow from the creation of the data up to print.

2-Layer printing Reference page|

Want to print a character in
the color of the color P.15
swatches of metallic color.

Print the part of the
illustration in Metallic color

Print a part of the photograph

Want to print a sunflower in a P18
in metallic color '

metallic color.

Want to print a silver polka P23

Print a pattern of Silver
P dots on black solid parts.

-14 -



Print a part of the illustrations in metallic color

This section describes this procedure from data creation to printing using the steps required to print the
character text of the illustration below in metallic color as an example.
By taking advantage of the swatch library of the metallic color, you can easily print the metallic color.

e
— —2 ——

|, e s _::f"’”'?
AN -
E M

+ Please create always a data in CMYK mode.

1 Create metallic color plate and color plate.
u

(1) Select a character on the application.

(2) Specify any color from the MIMAKI SS21 Metallic Color Library.

Specify the word "DEW" to
"Cold_01"

(3) Click [Setting] of RasterLinkTools.

(4) Setting screen is displayed. —— —— -

1 Check [Print Special Color Layer]
2 Click [Setup] button. 1

(5) Click [Output to RasterLink] button of RasterLinkTools to save the hot folder of RasterLink.

-15-



(6) The color plate and metallic color plate of the data

output to RL in step 1-(5) will be shown on the
RasterLink job list screen.

E dom|ged  Leswwd - ok e

» When doing so a composite image of color plate and
- metallic color plate will be formed automatically.

(7) Click [Color Replacement] i} icon.

(8) In [Color Replacemgpt] panel, confirm the s.pot coI'or }j‘;; L ey T
name that you specified in step 1-(2) exists in the list ; =

in [Spot color] tab. -'J:"“" — LE:"; .
| Ao WO R TS I i |
| e O WL r

2 Printing.

(1) Click [Layer] * % * icon.

(2) In [Layer Adjust] panel, select "Special Color — Color — Color" to [Special Color Over Print].

i e | i | PPt |

| i
TR | e P
il gl
} T S W -

Liter - Nl G~ Tem

L s

ahlty » Here you do not need to set the [Quality].
?-lF--r When change the profile in step 2-(5), it will be the default setting of quality.

(3) Click [Quality] [#] icon.

(4) Choose the job of metallic color plate in [Job List] —
. | aetsiiat | Fawonts |
panel of [Quality] panel. e

| JalName Ot Ovdiar

I Colon

ol
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(5) Choose the job of metallic color plate in [Job List] panel of [Quality] panel.

1 Choose a metallic color profile.

 Metallic color profile will have a [Si] to the end of the media name.

2 In [Device Adjustment], select “Profile Setting”.
3 Select the "ColorMatching OFF" in the preset of [Color Matching].

| rim— |

L . H

1 4[ {TUET i 2 W W :-]

L

. LS
T m
. e

%o |
b
A

= . i
o [ allndl . 2
S @ SEEe IFE W

-y | |

l '.'Ir\-'rIIl.r-: “’!I'l| u

3

« If the density adjustment of silver ink is
needed, specify the [Color Adjustment Set].

=)

(6) Choose the job of color plate in [Job List] panel of [Quality] panel.

(7) Set printing conditions with Print Quality tab.

Important !

* Please do not select the metallic color profile.

* Be sure to select the same resolution profile of the metallic color plate of the profile.

(8) Click [Execution] [ icon.
* Click button.

-17 -




To print the part of the photo in metallic color

Here, create three data of the metallic color plate overlaying the silver ink, color is not superimposed on the

silver ink plate and the Silver plate.
You can print the metallic color regardless the Image (raster) data or illustrations (vector) data.

Metallic color plate

Color plate

v Silver plate

1 Specify the range to print the silver ink.
u
» Here, explain how to create a path using the RasterLinkTools.

(1) Select the image on the application, and click
[Outline Extraction] button of RasterLinkTools .

(2) Click button.

» Adjust to make the range that you want to print the
silver ink traceable.

@LF + For the contour extraction function of = ! :
= RasterLinkTools, refer to the separate "RasterLink g TR aF row ik
T Reference Guide". 1 ol L | |
—_— - i

(3) Make sure that the layer of contour path (RL Trace
Layer1) is finished.

-18 -



2 Create a Silver plate.

(1) Set the fill color of RL Trace Layer1 that was created in step 1 to "Black”, and the stroke color to
"no fill".

,gal:i;: * Print the silver ink to the location of the "Black" of fill color.
'-_-ll=_-~' Please correct the path if the place you do not want to print the silver ink is in black.

(2) Display only the outline path layer.

el * Click . for the layer that you want to hide.

(3) Click [Output to RasterLink] button  of
RasterLinkTools to save the hot folder.

,gi;i;: « If you want to save to the hot folder, put the name of
?-l|_=_--' each plate in the file name for easy understanding.

3 Create a metallic color plate and color plate.
n

(1) Select the image and the layer (RL Trace Layer 1) of the silver plate.

(2) Click [die-cut] of RasterLinkTools.

* Layer of the Metallic color plate (RLMask Inversion
Layer 1) and the layer of the color plate (RL Mask
Layer1) will appear.

-19-




(3) Set to display only metallic color plate.

(4) Click [Output to RasterLink] button  of
RasterLinkTools to save the hot folder.

(5) Set to display only color plate.

(6) Click [Output to RasterLink] button  of
RasterLinkTools to save the hot folder.

4 Print by synthesized in RasterLink.
u
(1) Select Silver plate job from the [Job List] panel.

(2) In [Properties] panel, change [Job Attribute] to
"Mono Color".

 Display [Job Attribute] dialog box.

-20 -
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(3) In [Job Attribute] dialog box, set to print in silver ink monochromatic.

Tr—— Es
J i
]
| =54
Vg L
[T -h r—
1. First, select "Black" to T 2. Next, select "Silver" in color
o o S
replace the original color l :: l - after the replacement
| = |.....

IS.CIick Iﬁ button l

Toportd If you have created the data in RGB mode, you can not replace monochromatic color.
~ Please create a silver plate with the following procedure.

(1) From [Job List] tab, select the job for Silver plate. =
P B =
n e
s B ) =
(2) Click [Special plate] a' icon. [ -i_-]
(3) Select "Valid Pixel" in [Created area] " and "Silver" in Tpag———
[Ink], and click the (Create]button.
* The job of Silver plate is created. B
b=

(4) From [Job List] panel, select 3 jobs, Silver plate, |
metallic color plate, and color plate. Lt

(5) Click [Composition] = icon.

(6) In [Composition] panel, the order of the job from the _'_‘"“"'“"“_“|
bottom with the Silver plate — color plate — metallic e oo
color plate, then click button. ——— /- o
‘ \ ! |v| tallic color plat
@ Conditions that can not be synthesized Lan ealie colorea e

« If you have set the number of copies to two or more
* Split Print
- Step-and-repeat ‘ ! = Color plate .

* If the set of the selected job and resolution is differ-
ent
* Multiple page job ‘ \ W {

« If you have selected more than one cut jobs

@ If you can not set a separate profile printing
conditions, synthesize according to the | L P
conditions of one of the job. Compasite || ol
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(7) Click [Layer] * < icon.

(8) In [Layer Adjust] panel, select "Special Color — Color — Color" to [Special Color Over Print].

fi ¢ b e s e e |

;ﬁ.ﬂ.l‘-h

|
.u—. e

B LR

.. R ==
. FEET— e
o =

.}.-J-.T: » Here you do not need to set the [Quality].

When change the profile in step 4-(11), it will be the default setting of quality.

(9) Click [Quality] [#] icon.

(10) Choose the job of metallic color plate and silver plate
in [job list] panel of [Quality] panel.

(11) Set printing conditions with Print Quality tab.
1 Choose a metallic color profile.

» Metallic color profile will have a [Si] to the end of the media name.

2 In [Device Adjustment], specify the "profile settings".
3 Select the "ColorMatching OFF" in the preset of [Color Matching].

R T
e I et S— -
e - [ )| 4|1
LI T E
1 TR e IIIT Bl Wi t] |
p—s 5 3
I -
e e |
e =
= el « If the density adjustment of silver ink is
o | B — :l_-. = = . .
e ._-lE-L needed, specify the [Color Adjustment
e ————— '+ T —
e N R |- =—
——== =
e * |Efe=
ey e -
e
e e e -
| E— e " !-r"r
iy e L
=
==
2 ——(== Juioi=
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(12) Choose the job of color plate in [job list] panel of

s
[Quality] panel. J.u:un] o

'I'I!-dTLI:l'lH Aripiae | Job Mame | Ol Ceder

 Please do not specify the metallic color profile. SunFiowe_ 1]
~ « Be sure to specify the same resolution profile of the

I-; 2
metallic color plate of the profile. r1 m_

BT SunHDEE

(13) Set printing conditions with Print Quality tab.

(14) Click [Execution] [* icon.
+ Click button.

To print the texture of silver

Here, using a swatch pattern of lllustrator, print the pattern of silver.

1 Create a silver plate.
u

(1) Select all the objects that you want to print the
texture of Silver. .

(2) Click [Extract Frame] button of RasterLinkTools.

(3) Perform the following settings, and then click the Emtast Frase

et o = ——
1 Set [Offset] to “Omm”.

2 Uncheck [Extract the Inside]. e s ;

e L i

_,}.wl-:l,._ » For frame extraction function of RasterLinkTools, | [ ——— .,.} 2

- refer to the separate "RasterLink Reference Guide".

-
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(4) Create a layer of color plate and a silver plate.

2. Appear new layer

U Double click
i ——

(5) Divide the layer of color plate and a silver plate.
» Move the path that was created in step 1-(3) to the layer for silver plate.

* Click . for the layer that you want to hide.
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(7) The line of the path that you created in step 1-(3) to "None", and specify a set of fill color to any
of the swatch pattern in the swatch library.

------

e e e ",
i h e = s
L e I T
< DS RS D S B«
e T e B A e L
R
A" . -
‘.'.‘:'. . el + Use monocrome to the swatch pattern.
L _LFT:T + Print the silver ink to black place.

(8) Click [Output to RasterLink] button  of
RasterLinkTools to save the hot folder.

%

-

« If you want to save to the hot folder, put the name of
each plate in the file name for easy understanding.

2 Create a color plate.
| |

(1) In the Layers screen, duplicate the path for the Silver plate.

C. MEw Layed.,

Dupbicate “<Groups"
Dot " my e

Dptiof 3. Click the

"Duplicate” ... "
Mk e e

Enter Halabian Modse

(2) Move the path that was duplicated in step 2-(1) to the layer for the color plate
» Move to the top of the object you want to print the pattern of silver.

(3) Display only color plate.

. -
= R

+ [ re=
-
= L
L
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(4) Choose the path that was moved in step 2-(2).

Laymry

(5) Click the[Edit Colors]-[Invert Colors] from the [Edit] menu.

Prm— Where you want to print the Silver ink, do not
L : print the color ink.

(6) Display only color plate.

(7) Click [Output to RasterLink] button  of
RasterLinkTools to save the hot folder.

3 Print by synthesized in RasterLink.
||

(1) Select Silver plate job that was created in step 1. | i)
from [Job List] panel of RasterLink. ry— [-_;_ —

- % it
(2) In [Properties] pane, change [Job Attribute] to “Mono T mrr—— - ——
Color”. L_—Il -

Pt A (TR ———
« Display [Job Attribute] dialog box. S, [ h_ ]
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(3) In [Job Attribute] dialog box, set to print in sliver ink monochromatic.

171 o ——

1. First, select “Black” to
replace the original color

2.Next, select “Silver” in color

after the replacement

(=)=
1

3. Click button
l J

Important !

Please create a silver plate with the following procedure.

(1) From [Job List] tab, select the job for Silver plate.

(2) Click [Special plate] % icon.

(3) Select “Valid pixel” in [Created area], and “Silver” in
[Ink], and click the button.

* The job of Silver plate is created.

If you have created the data in RGB mode, you can not replace monochromatic color.

| ——
[ - - . W———
—p— l-—

(4) From [Job List] panel, select 2 jobs, Silver plate and
color plate.

(5) Click [Composition] = icon.

(6) In [Composition] panel, the order of the job from the

bottom with the Silver plate — color plate, then click £

button.

Tmportant! @ Conditions that can not be synthesized
- « If you have set the number of copies to two or more

* Split Print
» Step-and-repeat
« If the set of the selected job and resolution is
different
 Multiple page job
« If you have selected more than one cut jobs
@ If you can not set a separate profile printing
conditions, synthesize according to the
conditions of one of the job.

(7) Click [Layer] = & * icon.
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(8) In [Layer Adjust] panel, select "Special Color — Color" to [Special Color Over Print].

| v e |

.ui...l:l—:l o e

[ ————

i i e

.

}
Lo a |
- |

Y » Here you do not need to set the [Quality].
?-lg--r When change the profile in step 3-(11), it will be the default setting of quality.

(9) Click [Quality] [#] icon.

(10) Choose the job of Silver plate in [job list] panel of
[Quality] panel. J [7] Cluality Sewr.ops  Coloreps

| domtist | Famon |

Thismbmal  Amnbuls | JobNarw | Owipid Droer

Coloieps 1]

= ..
[

(11) Set printing conditions with Print Quality tab.
1 Choose a metallic color profile.

+ Metallic color profile will have a [Si] to the end of the media name.

2 In [Device Adjustment], specify the "profile settings".
3 Select the "ColorMatching OFF" in the preset of [Color Matching].

| o |

e O
LI T E
1 4[ TR e IIIT Bl Wi !-]
T -
5 e |
- bt « If the density adjustment of silver ink is
e e . E _lE: needed, specify the [Color Adjustment Set].

Y | L Pt el . 85 —
el - .
L T I -_—

L 4 E =

—— < fag=
e — o m— = -
-y
S et g el -
[EL TN = e
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(12) Choo§e the job of color plate in [job list] panel of _[*;“'* Favate |
[Quality] panel. _% ;

Thussrishai i P (O ST S T T e 1T

| I Sher  Steereps 1)

(13) Set printing conditions with Print Quality tab.

+ Please do not specify the metallic color profile.
~ + Be sure to specify the same resolution profile of the Silver plate of the profile.

(14) Click [Execution] [=] icon.
« Click button.
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Pull-back printing

Example of printing Reference page|

Print the part of the illustra- A Want to print a character in
the color of the color P.30

tion in Metallic color )
swatches of metallic color.

Print part of the illustration in Metallic color

This section describes this procedure from data creation to printing using the steps required to set the
character text of the illustration below to metallic color and printing it using pull-back printing as an example.
By taking advantage of the swatch library of the metallic color, you can easily print the metallic color

* Please create always a data in CMYK mode.

1 Create metallic color plate and color plate.
u

(1) Select a character on the application.

(2) Specify any color from the MIMAKI SS21 Metallic Color Library.

Specify the word "DEW" to
"Cold_01"

(3) Click [Setting] of RasterLinkTools.
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(4) Setting screen is displayed. . — —

1 Check [Print Special Color Layer]
2 Click [Setup] button. 1

(5) Click [Output to RasterLink] of RasterLinkTools to save the hot folder of RasterLink.

+ Check that RasterLink color collection settings have been configured for pull-back printing use
before outputting to RasterLink. = P.11 “Choose the color collection”

(6) The color plate and metallic color plate of the data output to RL in step 1-(5) will be shown on the
RasterLink job list screen.

(7) Select the metallic color plate job on the job list Ty
screen.

Eoamanged | —

I - |

I_':UJF‘\.'EI‘H'I.I. |- T

L o

(8) Click [Color Replacement] ¢} icon.

(9) Confirm the following two points on the “Color |~ - = S
Replacement” screen. J s e :
1 Check that the name of the spot color specified in
step 1-(2) appears on the spot color list
2 Check that the concentration of the silver being
output is set to 0 (Si:0)

] | S |

[qF =] ¥ i
B -. 4
OF & Wil vl e o

1 2

2 Create a Silver plate.

(1) Select a job that was created in step 1-(6).
(2) Click [Special Plate] %« icon.

(3) Click [Release] button.
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(4) Select the metallic color plate job on the job list | iiu] fuem |

screen.

(5) Click [Special plate] & icon.

(6) In [Special plate] panel, create Silver = ———]

& mrangesd

T

plate.

e ]

1. Select “Silver” in [INK]

e T E_"l.

2. Select “Valid pixel” in

v e [Created area]

3. Click (Create]

button

3 Print by synthesized.

(1) From [Job List] panel, select 3 jobs, Silver plate, | i ruees |

metallic color plate, and color plate.

(2) Click [Composition] w icon.

(3) In [Composition] panel, arrange the order of the jobs

from the bottom of the silver plate — color plate —
metallic color plate.

-32-
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(4) In [Composition] tab, select the color plate, check
[Pull back after Print], and click button.

,yLT; + Pull back media after printing the job that had a
= check in [Pull back after Print].

@ Conditions that can not be synthesized
- » If you have set the number of copies to two or more

* Split Print

* Step-and-repeat

« If the set of the selected job and resolution is

different
 Multiple page job
« If you have selected more than one cut jobs
@ If you can not set a separate profile printing

conditions, synthesize according to the
conditions of one of the job.

(5) Click [Layer] * < " icon.

J" for— |
s L] L AL L
I {
= = i
. I _
| ] il §
o
Composite || “aleuns

(6) In [Layer] tab, select "Special Color — Color" in [Special Color Over Print].

.I iR SRS N LSRN O I N N ki (R LSRR LT PRLITT P AT S| AREN R TR D
| | v | bt |
—— et e e t el L

-_._i._‘:.-......_.*_]i
(7) Click [Quality] [#] icon.

(8) Choose the job of Metallic color plate andsilver plate
in [job list] panel of [Quality] panel.
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(9) Set printing conditions with Print Quality tab.
1 Choose a metallic color profile.

+ Metallic color profile will have a [Si] to the end of the media name.

2 In [Device Adjustment], specify the "profile settings".
3 Select the "ColorMatching OFF" in the preset of [Color Matching].

| o | £

— I e ok ey

Bl bk —— :. l -.'-r;";-rrr."!?ll i u
1) —t.-n-u—.n: i 7:] |

[T A ——— La ] (3)
5 -
e R
S mal « If the density adjustment of silver ink is
...: i ;-.-:: _'F.T.-T needed, specify the [Color Adjustment Set].

Y | . e Sl - M =
cemm emea T —
S | e TR L] ———

——=1 e

—— < 2f=
B -
Ay -
P e L L e pr——
ET—g Filied
e £
e
S —————
- ——
@ == [8) ),

(10) Choose the job of Silver plate in [job list] panel of -
[Quality] panel. J +] Quality' DceanfEW_RL_LAYER_0Z_151311_0

[ ] rovoe

Thurmibnal | ASnbuls | Job fiama | Culpul Or,

DopaniiE H|

(11) Choose the job of color plate in [job list] panel of [Quality] panel.
« In [Print Quality] panel, choose the same resolution color profile of the metallic color profile.

 Please do not specify the metallic color profile.
~ « Be sure to specify the same resolution profile of the metallic color plate of the profile.

(12) Click [Execution] [¥] icon.
« Click button.
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Frequently Asked Questions

Answer the frequently asked questions and troubles from customers.

There is no gloss of silver and metallic color

Please check the settings of following items.

Setting item Settings
Check the settings of the « Follow the page 3 "Printer setting", make sure "DRYING TIM = 0.0s", and
[DRYING TIME] and the "LOGICAL SEEK = OFF".

[LOGICAL SEEK]

- Profile
Make sure that the metallic color profile including the [Si] in the name of the media
has been applied.

* Density adjustment
If you have made a density adjustment of silver ink, make sure that the color
adjustment set is applied.

« Color matching
Set the "ColorMatching OFF".

Check the printing conditions
of silver plate and metallic
color plate.
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